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Introduction

AndreaMosaic is a software that creates a photographic mosaic (also known under the term
Photomosaic, a portmanteau of photo and mosaic, trademarked by Runaway Technology,
Inc.). For more information visit the Wikipedia page about photographic mosaic.

To create such a mosaic you need a collection of images to use as tiles for the mosaic and
you also need an image to use for the original as a matrix for the mosaics. You can then
set the parameters of the program to create different kinds of mosaics.

Main Features of AndreaMosaic

Professional tool for production of high quality mosaics

Clear and Easy User interface

Automatic on-the-fly creation of image variants for higher mosaic quality
Automatic cropping of images to fit the selected tile aspect ratio
Advanced Mosaic rendering with intelligent color change for improved accuracy
Advanced analysis of the images

Optimal tile selection avoiding duplicates in the same area

Handling of large image collections and very large mosaics

Automatic Extraction of images from videos and creation of videomosaics
Four different tile aspect ratios: 1:1, 4:3, 16:9, 3:2

Free for personal/commercial use

AN N N N NN N N NN

Tile Variants:

¥ Original Tile Mirror

I/ Rotated 90° [ Flip Vertically
[l Rotated 180°

Load/Save Settings: T

O OO twse
Donate.) R \f) =

4> GigaPan n

Status:
Completed 68.33%, Time 00:00:01, Saving Mosai

Main Screenshot of AndreaMosaic
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Your first Photographic Mosaic

1. Create a Tile Images List

A Tile Images List is a list of all the images that AndreaMosaic will use as tiles to build your
mosaic. First, you need a Directory to store all your images to use as tiles. You can use
Windows Explorer to do this, or any other program. The images have to be JPG files. This
is the most common used format for photographs. You can also place the images in
subdirectories to organize them better.

The next step is to tell AndreaMosaic where the collection of your images is located. The
program will then analyze all the images and the result is stored in a Tile Images List (a file
with .AMC extension). This file contains the basic information of every image (the name of
the image, the size, in which directory/subdirectory it is stored).

1. Execute AndreaMosaic
AndreaMosaic
AndreaMosaic . SquareTiles(:1) | | DSLR Tiles (3:2) |

 RectangleTiles(4:3) | MovieTiles (16:9) |

2. In the Main Menu choose one of the
Tile formats, this will be the aspect
of your Tiles. Then the Main Screen

| Tutorial |

Please select a Tile Type or the Tutorial for more information.

will appear. Main Menu

Main Image to reproduce as a Mosaic: o 7 e ;
% Q @ | C:\Users\Andrea\Pictures\Mosaic Images\Teo Ziirich.jpg v: Naj @ ,}<_

Size Parameters: C:\Users\Andrea\Pictures\Mosaic Images\Teo Ziirich Mosaic.jpg

wossicsiee e~/ [ R s P T

Mosaic Resolution: 300 PPI

<

Tile Size: 100 tiles

Tile Param eters:
Pattern: Parquet (2L 1P)

1/ Tiles: 3,0%

<

<

<

4 Tiles: ‘o%

L€

<

Use same tile up to: i Unllmlted times

Duplicate spacing: i 3 tiles minimum

<

Color Change: §i30%

<

Tile Variants:
Original Tile Mirror

Rotated 90° [ Flip Vertically
C Rotated 180° . 4"
Load/Save Settings: Mosaic Information: |pixels v
0 +) o (Auto Save) Mosaic Max Size: 10.8 KP Tile Size: 1017 x 762 pixels = 0.77 MP
Main Image: 800 x 533 pixels Tile Pattern: 11 x 10 = 117 tiles
= — Final Mosaic: 10.8 KP x 7195 pixels = 77.7 MP  Tile Count: 117 + 0%2 + 0% = 117 tiles
o e T &R “~ ) File Size: 222 MB Tile Type: 76(L) + 41(P) tiles
- Donate é '\r ) :,) Border Size: 0 pixels List Type: 550(L) + 7(P) images
Gt Resolution: 300 PPI =
atus: @ (i
(@)
Completed 68.33%, Time 00:00:01, Saving Mosaic... 18.38%. ’? Glgapan n
[
Main Screenshot
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; =
- . In the new window that

3: Press the top right button Tile Images: ]
appears you can add the directories/folders where your images are located using the
Add Folder button or doing a Drag&Drop from Windows Explorer into the Folder
List. You can also add individual images using the Add Image button.

Location of the Tile Images List:
Images List: | C:\Users\Andrea\Pictures\Mosaic Images\Example Image List.amc |

| Openlist.. | New List | Save List i Save List As...

Folder Type: |Inc\ude Images/Folders (Populate using Drag&Drop or Add Image/Folder button) v ‘

Folder
C:\Users\Andrea\Pictures\Mosaic Images\example',

Folder List:

© Add Image | | Add Folder | | Remove Selected |

| Extract Tiles from Video... |

Black & White: [
Status: 550 Landscape images, 7 Portrait images.

4. If you used the Add Folder button then you will be asked to select a directory.
Note that only directories are shown, not the images.

Please select & Folder containing PG images:

i 2| My Documents
W My Music
4 2 My Pictures

4 | Mosaic Images

4 | example

[+ g ark

, cars
, cities

, nature

PR

Make Mew Folder
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5. If you want to add multiple directories you can also use Windows Explorer, select
several directories and Drag them into the Folder List.

E_E' Tile Images

Images List:

EE® Openlist.. ||

File Modifica Visualizza Preferii Strumenti 2 o

% C:\mosaic\example

Include Folders (Populate using D1

Indirizzo ([ J) C:'mosaiciexample v a Vai
Cartelle X Nome =
[ dex | ICplanes
# ) elzn IDother
=l I example - k
& 1) art k 4]
cars it Ih
g dities [Dycars
12 nature Eﬁﬂ =
) other Folder List:
) planes 2
< > < >
Oggetti selezionati: 4 j Risorse del computer

6. From the Drop Down list below the Open List button you can populate the "Required
Folders” and the “Exclude Folders”. The Required Folders will contain images that
are always used in your mosaic. Please don’t have too many images in those folders
because your mosaic will be less beautiful. The Exclude Folders are subdirectories of
the Include Folders that you don’t want to use for the tile list.

7. After you complete populating the Include Folders press the button Save or Save
As. AndreaMosaic will analyze all the JPG files that are in those directories and
subdirectories. You have to wait for the program to reach 100%. You can cancel the
process by pressing the OK button.

8. When the program reaches 100%, you will be asked for a location to save the Tile
Images List. Choose any location and any name. The creation of your List is now
complete, and you can go back to the Main Window. You only need to do this the
first time. In your future use of the program you can directly load your List using the
Open List... button.

Note: Whenever you change the images available in your Include Folders (moving,
deleting, adding, updating, etc) you must tell AndreaMosaic about those changes by
pressing the Save List button again. Whenever you do press this button AndreaMosaic will
verify that all images are available.

2. Set the parameters of the Mosaic

After you created the Tile Images List (or loaded an existing one), it is necessary to set all
the parameters of the mosaic. But for your first experiment you can leave the default
values. Later on with more experience and after reading the section ‘The Parameters of
AndreaMosaic' you can try different values.
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3. Select the Main Image

The third step is to choose what image you want to use as the Matrix of the mosaic. The
program will create a mosaic as close as possible to the main image.

™
1. Press the button {“" or drag a photograph from Windows Explorer (in JPG format)
into the Main Window of AndreaMosaic.

I L
2. If you pressed the {"” button then in the next window choose an image to use as
the matrix. If your image is in another format, for example Bitmap (BMP), you can
use any graphic program to save it in JPG. After the selection press the Open
button.

Lookin: | || vangogh [ ° Mv

I8

- PN
<5 S |
Recent places ﬁ' ‘ . e |

Desktop  4500x-Hiroshige... 120px-Hiroshige... 120px-VanGogh-... 120px-VanGogh-..

Libraries

Computer Radii s BT '

@
Nethrk File name: 120px-VanGogh-stamy_night jpg v

Files of type: irﬁage ('jpgx"png) v | Cancel
[ Open as read-only

L
Note: You can add more images to convert into a Mosaic using the {“" button again
or dragging multiple files from Explorer into the Main Window.

4. Create the Mosaic
The last step is to create the mosaic.

1. Press the button Create Mosaics: E

2. You only need some patience now. Especially if you have many images in your Tile
Images List (more than 10,000) or if you want to create a mosaic with many tiles
(more than 5000). In that case the process can take many minutes or hours. While
creating the mosaic you can see the details of the process in the Mosaic Information
area and the current step in the status line:
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=
ML E " ]
Mosaic Information:

Mosaic Max Size: 4960 x 3425 pixels Tile Size: 859 x 493 pixels = 325 KP

Main Image: 800 x 533 pixels Tile Pattern: 8 x 7 = 63 tiles

Final Mosaic: 4960 x 3304 pixels = 16.4 MP Tile Count: 63 + 0%2 + 0% = &3 tiles
j File Size: 7.4 MB Tile Type: 43(L) + 18(F) tiles

Border Size: 2 pixels List Type: 15920(L) + 4458(P) images

Resolution: 300 PPI

osaic... 33.33%. B Like

NANARNANARNRNARNARNARNANARNANNRNARNARRRNRRNANED ]

3. At the end of the process, a message will confirm that the mosaic was successfully
created, asking if you want to open the folder where the mosaic is stored. It is a
subfolder with the same name and location as each Main Image. You can also open
the folder by clicking on the blue text below the Main Image list:

ige to reproduce as a Mosaic:
Q Cr\mesaicitest\mosaic\Teo.jpg w

meters: C:\mosaic\test\mosaic\Teo Mosaicl?.jpg

L |.|'.'|.'1 vl
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In this Chapter you will learn more about the main interface of AndreaMosaic and the main
parameters for creating a mosaic.

B
The flag button -_-_-;.'ﬂ allows you to change the language of the program. If you are not
comfortable with the English language, click to see which other languages are available.

When you start the program you will be asked to choose the aspect ratio of the tiles in the

resulting mosaic:
F = AndreaMosaic

AndreaMosaic

‘ Square Tiles (1:1) ‘ DSLR Tiles (3:2)

Rectangle Tiles (4:3) Movie Tiles (16:9)

Tutorial

Please select a Tile Type or the Tutorial for more information.

Choose the version based on the images that you will use as tiles (i.e. the T7ile List). These
tiles will be automatically cropped a little bit on the borders when building the mosaic in
order to match the required aspect ratio.

Program Name Aspect Ratio | When to use

AndreaMosaic 4:3 With generic images

AndreaMosaic Cinescope 16:9 When your Image Collection is
based on movie frames

AndreaMosaic DSLR/NTSC | 3:2 When your Image Collection is

based on frames from USA
Television, Video Camera or
DSLR Cameras

AndreaMosaic Square 1:1 When you want that all tiles
have the same width and height

This section allows to save all the Mosaic Parameters. Press the ““** button to save the
current settings. Select one of the items in the drop down list to load the settings. Press

the U button to delete the currently selected settings. In the drop down list there are a
several automatic settings, “(Parquet)”, “(Landscape)”, etc, offering some predefined
parameters for different mosaic types.
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It is possible to transfer/save those settings to another computer by copying the
AndreaMosaicSettings*.txt files located in the AndreaMosaic program folder (usually
C:\Program Files\AndreaMosaic).

If you enable the Mosaic Settings in the More Options Window then for each created
mosaic there will also be a Mosaic Settings.txt file, containing all the specified mosaic

parameters. It is possible to reload those parameters for another mosaic with the O
button.

Main Image to reproduce as a Mosaic

This area contains the image (or list of the images) you want to use as a matrix for
creating your mosaic. For each image AndreaMosaic will create a mosaic and save it in a
subfolder located in the same folder as the main image. You can add/remove/clear images

e,
from the list using the buttons A , O and Q respectively. And you can add multiple
images to the list by dragging them from Windows Explorer into the Main Interface.

Irregular Main Image

You can specify an irregular main image by submitting a PNG file with a transparency layer.
In this case the transparent areas aren't filled with tiles and will be shown in the preview
with this pattern: . In that case the resulting Tile count will be less than the Tile
Count specified in the Mosaic Information area. Example Screenshot:

Main Image to reproduce as a Mosaic:

R
{)‘/ Q @ C:\Users\Andrea\Pictures\Mosaic Images\Teo Ziirich.jpg ol | ?
Size Parameters: C:\Users\Andrea\Pictures\Mosaic Images\Teo Ziirich Mosaic.jpg —
Mosaic Size: | 3 feet v
Mosaic Resolution: | 300 PPI v

Tile Size: 100 tiles v
Tile Parameters:
Pattern: Parquet (2L 1P)

<

14 Tiles: g9

<

<

a Tiles: g9
Use same tile up to: unlimited times v
Duplicate spacing: 3 tiles minimum v
Color Change: | 30% v
Tile Variants:
Original Tile Mirror

Rotated 90° [ ] Flip Vertically
[[] Rotated 180°

Load/Save Settings: Mosaic Information: pixels v
Q [ O (Auto Save) v Mosaic Max Size: 10.8 KP Tile Size: 1017 x 762 pixels = 0.77 MP
S Main Image: 800 x 533 pixels Tile Pattern: 11 x 10 = 117 tiles
Final Mosaic: 10.8 KP x 7195 pixels = 77.7 MP  Tile Count: 117 + 0%2 + 0% = 117 tiles
[ £ - File Size: 222 MB Tile Type: 76(L) + 41(P) tiles
Donate @ U 3/ Border Size: 0 pixels List Type: 550(L) + 7(P) images
Grat Resolution: 300 PPI =
Status: @G n
All Parameters are correct :-) 2 GigaPan
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The size parameters specify how big your mosaic will be and how big each tile will be.
These are the most important parameters.

Mosaic Size

This value is the total size of the final mosaic. You can specify any unit of measure shown
in the drop down list: pixels, megapixels, inch, feet, meter, cm. For your convenience
abbreviations are also available: " for inch, ' for feet, PX for pixel, MP for megapixel. The
list offers you some standard sizes but you can write your own size, for example: 38" or
38 cm or 38 MP. The resulting mosaic will have its longest size no bigger than the value
you specify. You can also set the width and height separately, for example: 50x40".

One particular case is with the size in pixels: if you specify 5000 PX then the maximum
width/height is 5000 pixels, but if you specify 50 MP then the total size width x height is
50 megapixels.

If you want the maximum possible size specify a value of 200 MP, it will create the
biggest possible mosaic for the standard version of AndreaMosaic. If you need a bigger size
you can get the professional version allowing to generate mosaics up to 8000 megapixels
(about 30 feet / 10 meter at 300 PPI or 45 feet / 15 meter at 200 PPI). If you need more
please contact the author of AndreaMosaic.

Mosaic Resolution

With this parameter you choose how many pixels per inch you need for your mosaic. The
default resolution of 300 PPI (pixels per inch) is already very high, it creates 90 thousand
different color points per square inch, with each point/pixel having one color from a
combination of 16 million different colors.

Normally you can accept the default resolution, but if you are going to print a large mosaic
(5 feet or more) then I suggest you drop the resolution to 200 PPI or less, or else you will
be going over the 200 megapixel limit of the standard AndreaMosaic version.

Tile Size

With this parameter you choose how many tiles you want or how big each tile is. As with
the Mosaic Size you can specify any unit of measure and use the abbreviations to specify
the size of each tile. I suggest you make tiles no smaller than 1.5 cm / half inch.

You can also specify the total number of tiles (for example 2000 tiles). In that case the
size of each tile is calculated automatically. In the Mosaic Information Box you can see the
final size of each tile in pixels / inch / cm.

E—_
- E. A"
pixels #
Mosaic Max Size: 4960 x 3425 pixels Tile Size: 639 x 493 pixels = 325 KP
Main Image: 800 x 533 pixels Tile Pattern: 8 x 7 = 63 tiles
Final Mosaic: 4960 x 3304 pixels = 16.4 MP Tile Count: 63 + 0%z + 0% = 63 tiles
File Size: 7.4 MB Tile Type: 45(L) + 18(P) tiles
Border Size: 2 pixels List Type: 15920(L) + 4438(P) images
Resolution: 300 PPI
g Like

0s5aic... 33.33%.
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Another possibility is to specify the number of tiles for each row, for example 50 tiles x
row. In that case the Mosaic Information box will show the resulting size of each tile and
the total number of tiles. Note that the number of tiles is an approximate number.

The Tile parameters described below will define the distribution of the tiles.

The pattern allows you to create mosaics where the tiles have different placements. If you
change this value you will see a visual preview of the final mosaic pattern. The following
groups of patterns are available:

Pattern Description

Standard The mosaic will contain tiles in Landscape/Horizontal format only. If your
Tile Images List has Portrait tiles then you must activate Tile Variants: [x]
Rotate 90° or these images will not be used.

Portrait The mosaic will contain tiles in Portrait format only. If your List has
Landscape/Square tiles then you must activate Tile Variants: [x] Rotate 90°
or these images will not be used.

Mixed The mosaic will contain a mix of images in Landscape & Portrait format. The
tiles are placed alternatively by landscape or portrait rows. The two
numbers shows the ratio between landscape/square images and portrait
images. For example “Mixed 3.8L 1P"” means that for each portrait tile in the
mosaic we will have nearly 4 (3.8) tiles in landscape format.

Parquet The mosaic will contain a mix of images in Landscape & Portrait format. The
tiles are mixed like in a Parquet pattern. As with the Mixed format the two
numbers show the ratio between landscape/square images and portrait
images.

If you use the Mixed/Parquet pattern then look at the line “List:” in the Mosaic Information
area. It will show you how many tiles in landscape/square format you have in your Tile
Images List and how many images in portrait format. See the Mosaic Information
paragraph below for advice on how to use this information.

When greater than 0% then these two parameters will split existing Tiles of the Pattern in
2 Tiles or in 4 Tiles. The percentage determines how many tiles are split. AndreaMosaic will
choose automatically which tiles to split to improve the overall quality of the Mosaic.

If for example I set Tile Size “1000 Tiles” and 2 Tiles “10%" then AndreaMosaic will split
10% of the 1000 Tiles. That means that the resulting Mosaic will have 900 Tiles with the
standard size and 100 Tiles split in 2 producing 200 smaller Tiles. The effective final
number of Tiles is then around 1100. The Mosaic Information Area will show those values.

The two tile duplication parameters specify how many times an image of your Tile Images
List can be used for the final mosaic (improving its quality). The duplication is necessary if
you have less images in your tile images list than tiles in the mosaic. For example, if your
Tile Images List is made of 500 images but you want to create a mosaic of 2000 tiles, you
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must allow the duplication (at least 4 times). If not, you will get black tiles. Another reason
for allowing tile duplication is to improve the overall quality of the mosaic.
It is suggested to specify just one of the two parameters, both are usually not necessary.

Use same tile up to ...

One possibility is to limit the number of times an image in the Tile Images List can be used
inside the mosaic. The disadvantage with this option is that the same tile can appear
several times close to each other in wide areas of similar colors.

To specify a maximum count for an individual image, you can include MAX[n] in its
filename, with n being the maximum duplication count. Example: The image
“MyFlower_MAX[20].jpg” will be duplicated up to 20 times. The MAX[n] parameter can also
be used in a folder name so that all images within that folder will have the custom
duplication value. Remember to (re)save the Tile List whenever you rename/add/remove
Image files used by the Mosaic.

Duplicate spacing

With this option you specify the minimum distance between two duplicated tiles. A value of
"2 tiles minimum” means that there will be at least one tile between an image extracted
from the Tile Images List and its copy. The variations of an image are to be considered as
a duplication. Also the custom variations (see the More Options) are treated as a
duplication.

Note that you need to have enough images in the Tile Images List, a minimum distance of
N tiles requires at least (N*2)2 tiles in your Tile Images List, so a distance of 5 tiles
requires about (5*2)2 = 100 images in the tile images list. But you probably need more
images.

To calculate the maximum value use the reverse logic, so if your Tile Images List has for
example 500 images then you should not use a value higher than v500/2 = 7.

In short higher values will lead to mosaics with a higher variety of different images but the
overall quality of the mosaic will look worse. Usually I set this number as high as possible
based on the number of images in my Image Collection. I suggest this table:

Images in the Tile Images List Duplicate spacing
Less than 50 2

Between 50 and 200 3

Between 200 and 1000 4

Between 2000 and 5000 10

Over 5000 images 15 or higher values

With this parameter you set how much each tile can be modified to make a better looking
mosaic. Higher values will produce better mosaics but each tile will look different than its
main image. Too high values will lead to ugly looking tiles. The option Original will use
each tile image as it is.

In the More Options - Color Change Priority you can specify how the tiles are modified.
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Another trick to produce a better looking mosaic is to make variations of every image in
your Tile Images List, and AndreaMosaic does this automatically. An image may not fit well
if used as is, but if rotated 180 degrees it maybe a better fit for a specific tile. The tradeoff
is that the image will look upside down. Using the available checkboxes you can specify
which variations are allowed. Note that you must select at least one. By default
AndreaMosaic will allow mirroring the image, rotating left/right by 90 degrees and of
course the original image as it is. The following table shog\/s the available variations:
Sl

igiﬁﬁi -

Rotate 180° Rotate 129

900 Left Rotate 90° Right

Mirrored Flip Vertically R.900° Left+Mirror R.90° Right+Mirror

Custom Tile Variants

You can create your own custom variations if you set the More Options > Mosaic
Processing parameter to the value Custom Tile Variants. You must then provide a different
image for each variant you want to create using a special file naming convention. You do
not have to provide one or more variations for each original image.

Example: You want to add "45 degrees Rotation" as well as a cropped version of the
Lizard.jpg file. To do this we add three underscores to the original file name followed by
the variation name. The resulting files (with different sizes) will look like:

Lizard___ Original.jpg Lizard___Rotated4s5. ipg Lizard___ CroppedToEye.jpg

Using the High Quality or Faster processing AndreaMosaic would treat those three files as
different images. Using the Custom Tile Variants processing AndreaMosaic will handle those
three files as variations of the same image, just like Mirroring, Rotating 90° and so on. It
will take advantage of the Tile Duplication parameters where AndreaMosaic tries to avoid
placing duplicated tiles near each other.

Note that AndreaMosaic will apply the Mirroring, Rotating, Flipping variants to each of the
three images producing in this case a total combination of 3 files x 8 variants =24 different
images.

This area will show you information about the resulting mosaic, the final size in pixels (but
you can view it in /nch or ¢m too), the number of tiles for each row and column and the
total number of tiles, the size of each tile, the size of the border for each tile and so on.
The List line shows the number of images/videos in your Tile Images List that are in

AndreaMosaic 3.34 - Copyright © 1997-2013 Andrea Denzler Page 14 of 41



Landscape/Square format plus the number of images that are in Portrait format. This
information is useful when choosing the Pattern of our Mosaic. If we don't want to allow
left/right rotations of our tiles (Tile Variation: [ ] Rotate 90°) choosing a pattern with a
proportion of Landscape and Portrait tiles similar to the proportion in the Tile Images List
will give optimal results and better utilizes all the tiles.

Suppose that in the Mosaic Information we read “List: 300 Landscape Images” and “List:
100 Portrait Images”. This means that our list contains 300 images in landscape/square
format and 100 images in portrait format. An optimal pattern would then be “Parquet 3L
1P” or “"Mixed 3.8L 1P” because for each portrait image we will use about 3 landscape
images. The selection of the pattern is not important if we allow Tile rotations [x] Rotate
90° because each image can be placed in any position by rotating it.

This area will show you any message about your parameters and also the current status of
the mosaic creation.

Use this button to create/stop the mosaic creation

Use this button to select the images to use as tiles for the mosaics

N Use this button to access the More Options Window
Some information about the current version of AndreaMosaic:
& About AndreaMosaic
o Copyright (c) 1997-2012 Andrea Denzler
\Y Version 3.33.14 Beta - Tile Aspect Ratio 4:3
http://AndreaPlanet.com/andreamosaic
AndreaMosaic is a tool to create Photographic Mosaic images. Read the
Tutorial to learn how to get the best results.
http://AndreaPlanet. com/andreamosaic/artworks
English Language by Andrea Denzler.
Please Help translating AndreaMosaic in more languages.
AndreaMosaic uses Open Source components from other authors,
special thanks to those authors. Special Thanks to all the supporters!
Thank You! Thank You! Thank You!
ueﬁl?iggg (ece (Credits) (License) (License Online)
Derea Please support the development with a Donation.

What are you waiting for? Create your first mosaic!
Discover and accept every truth, it will change fear into love.
Help Ever, Hurt Never. You are what you think, so think positive.
Only you can change your life, so change what you don't like.
Give to others what you want to receive.
Lovetall z:nd enjoy ;Zur life :)tt

This button opens the User Manual you are reading now

g,_.‘m This button will allow you to change languages.
Donate This button will open the Web Page for supporting AndreaMosaic.
You can receive the Bonus Pack or the Professional Version.
g Like This button will open the Web Page with the various Social

Networks connected to AndreaMosaic.
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In this Chapter you will learn more about how to create a Tile Images List, in other words

how to select the images to use as tiles for your mosaic:
F = Tile Images

Images List: | C:\Users\Andrea\Pictures\Mosaic Images\Example Image List.amc
Open List... New List Save List Save List As...

Folder Type: | Include Images/Folders (Populate using Drag&Drop or Add Image/Folder button) v

Folder

C:\Users\Andrea\Pictures\Mosaic Images\examplel,

Folder List:

Add Image Add Folder Remove Selected
Extract Tiles from Video...

Black & White: []
Status: 550 Landscape images, 7 Portrait images.

OK

Tiles Images Window

Using the Add Folder / Remove Selected buttons, or dragging folders from Windows
Explorer into this Window, you will be able to populate the list of folders containing the
images you want to use as tiles. There are three list of folders:

a. Include Images/Folders: All images contained here will be used as tiles if they fit
the mosaic well.

b. Required Folders: All images contained here will always be used in all your
mosaics. Please do not include too many images in such folders because the final
quality of your mosaic will suffer.

c. Exclude Folders: All images contained in these folders will never be used as tiles.
Usually these folders are subdirectories of the Include/Required Folders.

d. Video Folders: All *.AVI files contained in these folders will be used as video tiles.

Using the drop down box you can select the list to display and modify. Use the Add Folder
button to add one folder to the currently selected list. You can use also drag from Windows
Explorer one or more selected files/directories to the folder list. If you add a file then its
parent directory will be added to the list.

Use the Remove Selected button to remove the selected folders from the list.
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Using the four List buttons you will be able to Load, Save or create a new List.

Open List... Use this button to open an existing tile images list you saved
previously using the Save List buttons.

New List Use this button to start a new tile images list. You need to add at least
one folder to the include folder list.

Save List Use this button to analyze the folder list, searching for all available

images (JPG format) in the Include/Required Folders and all its
subfolders. The images available in the Exclude Folders will not be
included in the list of images to use as tiles. When analyze is complete
the tile images list will be saved into a file (with usually the .AMC
extension).

Save List As... Same as Save List button but you will specify a new file name for the
list.

After you saved your current Tile Images List you can close this window and start creating

a new mosaic.

The Black&White option will let you create Black&White mosaics without the need to do the
conversion of all your tiles or of the final mosaic. AndreaMosaic will do this process
automatically on the fly. Your original images will never be modified.

Another option for creating Black&White mosaics is to use color tiles but a Black&White
image as the main image. If you specify a high Color Change parameter, something around

30%-40% then the resulting image will look Black&White but each tile will be a color tile
with a low saturation.

Read the chapter for instructions on how to use this feature.
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In this Chapter you will learn more about the advanced parameters of AndreaMosaic.

More Options

x

Mosaic Processing:
Image Compare:
Image Detail:

Color Change Priority:
Use All Images in the Tile List:

File Format:
Mosaic Directory:
Mosaic Subdirectory:

High Quality v
Best Quality v
Automatic v

Balanced Quality v
[

High Quality (.JPG 95%) v

{(Use Directory of Input Image) v

Do not create subdirectories v

Mosaic Filename: Save a new Mosaic v

Mosaic Web/HTML Page:

Text Report & Mosaic Settings:
Deep Zoom Composer:

Split Mosaic:

Create a Maskfile:

No Web Page v

ooon

Don't use consecutive: | No Frames "

Color: | Black v

Size: Mo Border W

Check for updates: (Beta) every week v

Show ToolTips:

Check Now

oK

Cancel Advanced Settings...

More Options Window

These parameters affect how the mosaic is created, the tile modifications, the processing
used, etc.

Mosaic Processing
This option specify how the images are selected:

High Quality This is the default option. It will produce a better mosaic in most
cases. The only drawback is a higher memory usage.
Faster This is a faster processing that uses the best image for every tile. It

also uses less memory but the quality is generally lower and with very
big mosaics it is also slower.

Custom Tile Variants is based on High Quality and it allows you to
specify your own tile variations. See the Tile Variants parameters for
more information about this option.

Custom Tile
Variants
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Image Compare
This option specifies how the images are compared to each other:

Best Quality This is the default option. It will produce the best results in most
cases.

Stronger This option will penalize images with higher differences

Weaker This option allow images with higher differences.

Image Detall

This option specifies how much detail is needed for the mosaic. The best choice is
automatic:

Automatic This is the default option. It will produce the best results in most
cases.

\I\;:ryDeL?‘:\: Detail U_se one of these low detail valu_es if you ha_ve a small _coIIection of

Low Detail Tile Images (less than 1000) or if the detail isnt much important.

Medium Detail This choice is a good balance.

High Detail

Use one of these high detail values only with a very large collection

Very High Detail of Tile Images (10,000 or more) available for the mosaic.

Maximum Detail

Color Change Priority

This option specifies how the images in the Tile Images List are modified to produce a

better looking mosaic. The amount of Color Change is specified in the Main Window:

High Tile Quality This option gives a higher priority to the tile quality. Only overall
changes are allowed like color tonality and luminance.

Good Tile Quality This option gives a good priority to the tile quality, but it also
allows some degree of changes to better match the mosaic
details.

Balanced Quality The default option balances the type of Color changes.

Good Detail Quality This option gives a good priority to details and color of the
overall mosaic, but the tiles will be changed in all aspects.

High Detail Quality  This option gives a high priority to details and color of the overall
mosaic. The tiles will be changed in all their aspects (tonality,
luminance, saturation, contrast and local changes).

Use all tiles in the Tile List

If this option is enabled then AndreaMosaic tries to use all tiles in the collection regardless
of their match with the main image. This option has effect only if the Tile Images List has
less images than the number of tiles in the mosaic.

These parameters specify how the mosaic is saved and what files are created.

File Format

You specify the file format and its compression. PPM/RAW/TIFF/BMP/PSB/PSD will give
best quality because there is no lossy compression. The PSB/PPM file format is the best for
giant mosaics (several gigapixels)
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Mosaic Directory

This parameter allows you to save the mosaic in a different directory than the main image.
The input image directory will be used by default.

Mosaic Subdirectory

You can specify a subdirectory to be created for each mosaic:
e Do not create subdirectory: all mosaic will be saved into the Mosaic Directory.
e Create a subdirectory: one subdirectory will be created for each input image.
e Create a new subdirectory: one subdirectory will be created for each mosaic. If you
run the program multiple times with the same input image then a new subdirectory
will be always created.

Mosaic Filename

This option allows you to specify the filename of the saved mosaic:
e Save a new mosaic: a new file name will always be used Mosaicl, Mosaic2, etc.
e Overwrite existing mosaic: the file name will always be the same (Input Image +
“Mosaic”). Note that if you create a new subdirectory, the final mosaic will have the
same name but it will be created in a different directory.

Mosaic Web/HTML Page
If selected AndreaMosaic will create a web page with the pixel size specified in the option.

Text Report File and Mosaic Settings

If selected AndreaMosaic will create a text file containing general information about the
mosaic and a table of all the used images. The columns are:

Column Description

Position Coordinates of the Tile in Pixels: Left x Top.
For example a coordinate of 100x600 means that the tile starts
100 pixels from the left and 600 pixels from the top.

Image The file name of the tile.

Sequence This is the absolute index of the Tile inside the sequence. It
has a meaning only if you use the Sequence algorithm.

Difference The difference between the Tile and the main image. Lower

values mean the tile is more similar to the main image. A
theoretical value of 0 means the tile and the main image are
nearly the same.

Used Count How many times that tile was used inside the mosaic.

Deep Zoom Composer

If selected AndreaMosaic will create a Deep Zoom Composer Project file that you can
publish on your web page using Deep Zoom Composer and Microsoft's Silverlight™
Technology. This option works well also if you allow the splitting of the final mosaic.

Split Mosaic

If selected the final mosaic is split into several separate images. When creating the mosaic
you will be asked how to perform this split. You need to set the Width and the Height in
one of the three available units: pixels, tiles or columns/rows. This option is useful for very
large mosaics as supported by the Professional Version of AndreaMosaic. If your mosaic is
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over the limits of the saved file format then a message suggest to enable this feature or to
switch to the PPM/RAW/PSB format. The PSB (or PPM) format is the preferred choice.

E Insert Split Parameters
Width Height Total
Size in tiles: 8 x 7 = 56
Size in pixels: 4960 x 3304 — 16387840
Width Height Total
Size in tiles: | 7.50 x 6.67 — | 50.09
Size in pixels: 4960 x | 3304 — 16387840
Number of Splits: 1 x 1 =1
OK Cancel

Screenshot of the Split Mosaic Parameters

Note:

e When inserting one of the Width (or Height) values then the other values of the
column are automatically updated.

e If you want each Split to have a specified size, then enter the Width/Height in Size
in Pixels. If you want all Splits to have the exact same size then enter the
Width/Height in Number of Splits.

e If you want to specify the size of each Split in Inch/Feet/cm/meter then you must
convert your size into pixels using the PPI specified in the Resolution. If your
Resolution is 300 PPI then 1 inch = 300 pixels. 1 foot = 12 inch = 3600 pixels. 1 cm
= 118.11 pixels. 1 meter = 11811 pixels.

Create a Maskfile

Please first refer to the section on Irregular Mosaic to understand what a Mask
File is.

If selected then AndreaMosaic will create a special file with the suffix Maskfile.jpg
containing the currently selected Mosaic pattern converted into an Image. It is possible to
edit/modify this pattern and use it later as a template for new patterns like for the creation
of irregular mosaics. To use this file please specify “MaskFile” the Mosaic Size parameter.

Don't replicate consecutive frames: specify this parameter only if your tiles are frames
extracted from a movie, and to avoid that two similar frames be placed near each other. All
frames within the distance of this value are supposed to be similar. For a custom distance
replace 'nnnn' with the value you want.

AndreaMosaic 3.34 - Copyright © 1997-2013 Andrea Denzler Page 21 of 41



If your image collection is an extraction from a movie file, then it probably includes many
similar images, called frames, and they are near each other. The filenames are all in the
form:

MYMOVIE_FRAMES001\FR00001.JPG

MYMOVIE_FRAMES001\FR00002.JPG

MYMOVIE_FRAMES001\FR00003.JPG
So even if you use a high value for the Distance parameter of duplicated tiles, the program
may use many similar images for an area of the mosaic because the frames are very
similar. If this happens I suggest to use a value for this parameter. In other words, if you
set a value of 5, then two tiles can only be close to each other if there are at least 4 frames
between two tiles inside the sequence of the frames. I suggest to slowly increase this value
as needed for a particular Tile Images List.

IMPORTANT NOTE: The sequence parameter will only be used for directories (or files) that
contain the name “"FRAMES". So you could have in one Image Collection both Frames using
the Sequence Algorithm and standard images using the normal Distance Algorithm.

This parameter allows you to specify a border around every tile. This is useful to better
separate the tiles from each other. You can specify any color for the border as well as its
size using one of the standard unit of measures (pixels, inch, cm, etc).
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Movies are great for mosaics because they contain a lot of images, and as you know we
need a lot of images to create good photographic mosaics.

1. First Step — Find a movie/video

Your first step is to find @ movie/video and to import it into an AVI file. For example
- Use your video camera to make some nice movies while you are on holiday.

- Rent or buy a VHS cassette or a DVD

- Download a movie/video/avi/divx file from the internet

Downloading something from the internet is probably the simplest solution, because
otherwise you need a card in your PC to import the VHS into your computer and translate it
into an AVI File. Another solution is to read the movie from a DVD, but you need a DVD
Ripper that convert it into a video file (avi or divx for example).

At last the only requirement is that you have a VfW video codec installed on your system
that handles your movie correctly. Please read the following chapter “Video support in
AndreaMosaic” for detailed instructions.

2. Second Step — Extract the Images from the Movie

AndreaMosaic has an integrated tool for extracting images from a movie. But of course you
can use any kind of program that analyzes the Movie file and extracts Images.

Instructions:

1. Open the Tile Images dialog by pressing the button Tile Images.

2. Then press the button Extract Tiles from Video...

3. You will be asked to open an AVI/MPG/DIVX/XVID file. Those are only suggested
extension. Any file is ok if you have the correct codec installed.

4. After you selected the file AndreaMosaic will show a dialog box with the parameters
for extracting the Images from the movie. Select the appropriate values and then
press the button Extract to begin the process. For a description of the parameters
see the next section.

5. The program will analyze the movie file and create several new subdirectories in the
same location as the movie file, with all the extracted images written into those
subdirectories. The program will never cancel or overwrite existing
directories/images, so you have to remove the images manually if you repeat the
process more than once.
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Parameters of Extract from Movie Window

Frame Size / Position: Left, Top, Width, Height:

The first four parameters are the size of the frame that you want to extract. Normally you
can leave the default values, but if you see in the Sample Frame that the white rectangle is
bigger than the image then you should change the values to a smaller frame. Whenever
you change the position or size, you need to press the button Show Frame to update the
white rectangle. If you can not see the image of the movie well try with a different frame
by pressing the button Random Frame. It will choose another image.

Frame Selection: First/Last

These two parameters let you choose which interval of frames should be extracted. The
default values are set to extract the full movie. But you can specify different values, for
example to discard the first few images. You can then press the button First Frame or
Last Frame to show the first visible frame you chose.

Frame Selection. Count

Usually in @ movie there are a lot of frames, and a lot of these are similar to each other. So
practically we only need a small number of images. Here you can choose how many
images you want. I suggest 5000 as a minimum value, but if you can also try 20,000
frames. This will produce better mosaics since you have more images, especially with long
movies.

The program will then extract 5000 frames evenly distributed between the first and last
frame you chose in order to get the best possible images without too many similar ones.

De-Interlace:

Set this option only if you see “strange” horizontal lines disturbing the image. This can
occur especially when your movie file was recorded with a video camera or converted from
a VHS cassette. It is better to avoid the use of De-Interlace because technically by
removing the lines this option reduces the image quality.

File Format:
If you want to use the images to create mosaics then you have to choose [x] JPG Format.
The BMP option is only here for your convenience.

Quality:

This parameter is only needed if you save JPG Images, it specifies the compression of
every image. Higher values result in bigger files, but also better quality. A default value of
50% is O.K., but you can use higher or even lower values. When used to create mosaic,
the frames will be resized to smaller images, so usually it is not necessary to set a high
quality. I suggest a value of at least 70.

3. Third Step — Analyze Images

Once you have extracted a good amount of images use an Image Browser to take a look at
all the frames. I suggest deleting duplicates or images that are not nice. I always check all
the frames. With a good image browser (I suggest the free FastStone Image Viewer) you
can see the thumbnails of 50 images in one screen and delete immediately those that you
don't like. At last you can create the Image Collection based on the extracted frames.
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This is the movie extraction screen after opening one of my preferred movies:

First: |0

Count: 5000

File Format: ‘JPG
[IBMP
O

Quality: | 90

File Prefix: | FR

The extraction will create NEW
subdirectories called FRAMES001, The white rectangle shows the part of the frame that will be extracted. Modify Top/Left/Size
ERAMES002. values and press the button Show Rectangle to update that rectangle.

Extract H Cancel ‘ l Show Rectangle H First Frame H Random Frame “ Last Frame

: =% Extract Frames from Yideo/Movie

Left: |0
Top: |6
Width: | 720

Height: | 405

[ Auto ][ Max J

First: |0

Count: 5000

File Formét: JPG
[ BMP
O

Quality: | 90

File Prefix: | FR

The extraction will create NEW

subdirectories called FRAMES001, The white rectangle shows the part of the frame that will be extracted. Modify Top/Left/Size
FRAMES002. values and press the button Show Rectangle to update that rectangle.
Extract ‘ [ Cancel l I Show Rectangle ’ [ First Frame ] | Random Frame H Last Frame
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The most common problems occurs when trying to open the AVI file. AndreaMosaic is
using a older (and more simple) technology called “Video for Windows"” or VfW. It requires
to have a VW compatible codec installed. This feature is only available under Windows (no
Mac/Linux support).

1. First Step — Recognize the codec used in your Video

Download and Run the GSpot program (http://en.wikipedia.org/wiki/GSpot). Add your
video to it. It will show you what codec is required. In the following example we need a
DX50 codec (see the Red Rectangle). This code “DX50"” is the “FourCC” character that

uniquely identifies the codec. It is also called DivX.

Is' GSpot v2.70a: Kung Fu - 2x02 - Un vero amico
File System Options Tables Help

L] f)}mf Yideo
Fil o
lle Codec [DE0 Mame Divi B.0.3 Fusion [TH 2252
™" g

Pt D:\Kung Fu - 240..n vero amico.avi —| .. | Status Codec(z] are Installed HEEH
Size|350 ME (358,616 KB / 367,223,296 l:l Ao

DI TS ) | Ml | o= Foc too
Tast el ] = s170 5240
=4
ﬂ REEE e =
FITETTETTETT T E——uo="xw=

5] [5[=]t max {x| 31037 avg / 300 max

t
Len 4716120 Frme (70903 khps 946 Qf 0123

Picsds [25.000 Frames’s [25.000 Fields/s

FROG IfL TFF EFF FFF = FAL HNT=C
d
ﬂ E H fum — pic [w = 540 x 480 zeq ext 4z 18:3
zar (1,333 (4:3]  par 1.000(1:1]  dar 1.333 [4:3)

Resizing [ e i[5 [reod[Ewco] oy [eve]
1 I | K=

2 info

Audio
Codec (020055 MPEG-1 Layer 3 EA E3
Info |48000Hz 80 kb tat . Steren
=] (=] (<] Stat| Codecls]Installed

Propozed Codec Solutions and Tests

GSpat WS [Sro)-xr-fal-x[avi Splitter Jx (B> [ffdzhow Video Decoder J:-[C}->[Video Renderer ]
Wid aud | A0 Wideo Render OK. Use [3] to play.

[Sro)-r-[A]->[AV] Splitter ]»-[B]->[ffdshow Videa Decoder [»-[C)-»[Video Renderer |
ﬂ ﬂ ﬂ Wideo Render OK. Use [3] to play.
Bl 2] | 2

Bl =] < >

Another free software is Medialnfo (http://mediainfo.sourceforge.net/):
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' MediaInfo - M:\Butterfly.wmv =] &3
. File =7 view 7gh Options i) Debug 4l Help # Language

| Iru1:\Condivisione\Elutterﬂy.wmv jJ
*Container and general information )

&

Encoded date: UTC 2006-03-08 01:44:40.600

Comment: Courtesy of Robert Millis. Used by Permission
WhISharedUserRating: 99

WHMICategory: Sample

Windows Media: 2.67 MiB, 105 176ms
1 video stream: VC-1 (WMV3)

Amdin b IR

2

rFirstvideo stream
1895 Kbps, 720%480 (1.500), at 29.970 fps, VC-1 (WMV3) (NTSC) (MP@ML)
[: fifi
rFirst audio stream
96.0 Kbps, 48.0 KHz, 2 channels, WMWA (Version 2)
Go to the web site of this audio codec |

9 EC

Mote : for more information about this file, you must select a different view (Sheet, Tree...) —=

2. Second Step — Install the Codec

The second step is to find and install the correct codec. The software K-Lite Codec Pack
has several VfW codecs as shown in this screenshot. It supports among other things the
common XVid/DivX codec. Don’t install the full package but only the VfW codecs as
described here:

gm Setup - K-Lite Codec Pack M= E3 |

&

Select Components .'::
Which components should be installed? Q
IEustum Selection j

[ Other filters: |
[ Haali Video Rendsrer
WP wideo codecs:
fidshow WPW interface
[ wvid1.22
=
bbby
) RS el
O ACM audio codecs:
- O MP3 [L&ME) —
- [ ac3acw |

Current zelection requires at leazt 19.7 ME of disk space.

Help | ¢ Back I Hext » I Cancel |

Download the Mega version here http://www.codecguide.com/download kl.htm
Run the setup and select Advanced Mode.

Then click Next until you reach the Select Components Window.

From the list box choose the last profile option: Deselect All.

Then scroll down the list and select only the VFW Video codecs. Click Next until
installation is complete.

vhwhe=
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3. Third Step — Convert your Video

If you are still unable to open the video then you are probably still missing the proper
Codec on your system. For example the Microsoft WMV or QuickTime MOV codecs are not
supported by VfW. One workaround is to convert your Video into the AVI format using the
XVid codec:

1. Download, install/unzip and run the free AviDemux program
(http://www.videohelp.com/tools/AviDemux).

2. Open your video file and select the destination format:
Video Codec: MPEG-4 (Xvid)
Audio Codec: AC3
File Format: AVI
With the Filters button you may add some extra processing, like resizing the Video
to a very small size in order to use it as tiles for the VideoMosaic.

B4 greenpeace.wmv - Avidemux | _ (O] x]
File Edit View Video Audio Tools Go Auto Custom Help

=0 E&8 0 F3IEx

Video
Configure
Filters | h
Audio |
IMP3 (lame) v] ]
Configure I

Filters I
I~ shift: IO 3: ms

-

= O m O
Selection

VOOV OUMmIE® GO W a_ooooo_|

Frame: [0 /2187  Time: [00:00:00.000  /00:01:27.480  Frame Type: I(05) B: 002187 |
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3. Add Job
Select File -> Add to Job List. Then insert a jobname and the Output file. In this case

C:\greenpeace.avi

B3 greenpeace.wmv - Avidemux [_TO[x]
File Edit View Video Audio Tools Go Auto Custom Help
o [Ew=E

Recent Files »

Append... Ctrl+Alt+A "

Save »
Close Crl+w
O Information... Alt+Return

; Load/Run Project...
& Save Project . & save Job

ﬂ Save Project As...
Job name: |greenpeace
'
Output File: IC:\greenpeace.avl

View Joblist... Ctrl+1

Connect to avsproxy

Quit

H

—13

=
Selection

VOGO LETLE® GOV A oooo00
Frame: [0 /2187  Time: [00:00:00.000  /00:01:27.480  Frame Type: (05) B: 002187

4. View and Run Job
Select File -> View Job List. Then press button Run All Jobs.

EAJobs
i | 2 | 3
T T
ﬂgreenpeace Jjs iReady 100:00:00
T SO N E O

Delete Sel, Job

EE—
Delete All Jobs |
[

oK | Cancel |

When completed you can try to open the resulting Video in AndreaMosaic. It should

work.
B3 Encoding.... [ 2]

Phase: Encoding Processed Frames: 243
Video Codec:  Xvid Total Frames: 2138
Audio Codec: MP3 Quantiser: 4
Container: AVI Average Bitrate: 745kBfs
Video Size: 0ME Elapsed: 00:00:15
Audio Size: O MB Time Remaining: 2 minutes
Total Size: 1MB Frames/sec: 15.28

i 1%

[ ishut down computer when ﬁnishedé Priority: [Below Normal =

Pause [ Abort
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The freeware version of AndreaMosaic has some limits in creating a photomosaic:

Maximum number of pixels in the final photo mosaic 200 Megapixel

Maximum number of pixels in the final video mosaic 5 Megapixel

Maximum number of tiles in the final mosaic 32,000 Tiles

Maximum number of images in your Image Collection | 100,000 Images

However, if you make a donation to support this program then you can get the
Professional release where these limits are much higher:

Maximum number of pixels in the final photo mosaic 100 Gigapixel

Maximum number of pixels in the final video mosaic 100 Megapixel

Maximum number of tiles in the final mosaic 500,000 Tiles

Maximum number of images in your Image Collection | 500,000 Images

If even these limits are too low for your needs then please contact me for specific help and
support.

If you support the development of AndreaMosaic in any way then you will receive the
optional Bonus Pack. This pack contains a few more patterns and higher allowed values for
the 72 Tiles and Va Tiles parameters in the main screen. For more information see the
Donation page www.AndreaPlanet.com/andreamosaic/donation or also the Frequently
Asked Question (FAQ) page www.AndreaPlanet.com/andreamosaic/faqg.
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Mosaics with few tiles

I think that the most beautiful photo mosaics are those made with fewer tiles that are still
able to reproduce the main image. Mosaics in this category are made with less than 600
tiles. The main problem is that you need “good” tiles, so it is usually necessary to have a
very high number of images in your Image Collection. I usually use at least 20,000 nature
photos.

How to create a mosaic with few tiles:
1. Prepare a Tile Images List with many images.
2. Set the parameter Tile Size to a number between 100 tiles and 600 tiles. I
usually use 250 or 500.
3. Choose an Image to transform into a mosaic that has few and big details and with
several different rich colors.

Here are some examples:

~wAndrea
Planet
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Planet

AndreaMosaic 3.34 - Copyright © 1997-2013 Andrea Denzler Page 32 of 41



When I wrote this program, I wanted to create irregular mosaics. So this is a first attempt
on the path of irregular photomosaics. Write to me if you have any questions about this
feature.

The MaskFile:

You first need to create a “Maskfile”. This is a regular image where each colored area will
be replaced with a tile from your tile images list. The size of the maskfile determines the
size of the final mosaic (cropped to match the aspect ratio of the input image).
AndreaMosaic will analyze the maskfile and create a tile for each contiguous colored area.
It is important to use uniform colors (no shading or fading) and to save the maskfile using
the maximum JPG quality.

AndreaMosaic will recognize two special “colors” inside the maskfile:

e White: anything that is white will be treated as the background. No tiles will be
placed there and in the final mosaic the white will be replaced with the Border color
specified in the More Options window. So the white color is useful to create a layout
with borders or to create a layout where some areas of the mosaic will not contain
tiles.

e Black color: anything that is black will be merged with the nearest tile. So this is
useful to draw a tile using black lines or curves that will be removed in the final
mosaic. Note that colored areas that are too small will be merged with the nearest
tile.

AndreaMosaic can help with the creation of a Mask File. See the explanation on the
parameter Create a Mask File of the Option Window

How to create a mosaic using a MaskFile?

1. Set the parameter Mosaic Size to the value Maskfile. The parameters Tile Size,
Pattern and More Options—>Tile Borders are ignored. The Mosaic Information will
show only some of the usual information.

2. When you press the button to create the Mosaic you will be prompted for a JPG file
(the MaskFile) that contains the template for the Mosaic. You can also specify a
Folder containing several MaskFiles, in that case a mosaic will be created for every
MaskFile (image) contained in that special Folder. An example of MaskFile is shown
below.
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Maskfile with a border
Using a paint program I drew several white spirals over a uniform blue background.
According to the maskfile rules we will have one tile for each blue area with the white lines
relaced y the baround cor specified in AndreaMosaic.

N

Mskfi with White Linite will be elac wit the rder cI)

e

e

Detail of the Center
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Let’s use our “Teo”

as our input image and the default black color for the border.

Input Image | | F/né/ osa;'c
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Maskfile without a border
Let's replace the white lines in our maskfile with black lines. The resulting mosaic should

have the same aspect but without any border at all. Let's compare it with the previous
example. The resulting mosaic is similar but the missing border changes the overall feel:

B }

- 35NN
9.7 s

O el
X24\E v{g_m.a T
PR s i
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Detail of the center (with border).

Which one is better is a matter of taste. The missing border offers a more artistic mosaic.
The border helps to better recognize the individual tiles.
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Detail of the Maskfile with black lines (the black border will be removed)

Maskfile with color areas

You do not need to build a maskfile with lines to separate the tiles. AndreaMosaic can use
different color areas to make the tiles. And you can also mix white and black lines/areas in
the same mosaic. In the next example we have several polygons built over a white
background, so that the white area will not contain any tiles.

s
o

Detail of the MaskFile

The resulting mosaic will replace the white color with the default black border color:

. s a i _
3 /:)\ s B4 A8 %3 A .
Mosaic with partial areas
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Background color rep/aced with ma/n image

Using a Photo Editor I replaced the black background with the main image (resized to
match the final mosaic). The mosaics in these examples were built with the sample image
collection containing only 500 photos. The more images in our tile images list the better
the final result.
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A recent introduction is the possibility to create video mosaics (Mac/Linux not supported).
The final result is a Video (AVI file) where each frame is a photo-mosaic. AndreaMosaic
tries to reproduce a still image where each tile is a video clip or a still image. To realize this
each video clip must be a relatively static video. The main problem is to get a large
collection of short video clips suitable for this use. So here is a new feature that extracts
short video clips from a common movie/video.

Create Video Clijps

First of all we need to build a high humber of short Video Clips with a fairly stable content.

1. Select a video/movie on your computer and resize it to the approximate size of the tiles
in your mosaic. A VideoMosaic at High Definition (with 720 lines) and 250 tiles will have
a Tile Size of about 60x40 pixels. With an HD 1080p VideoMosaic each tile will be still
less than 100 pixels. So it is totally useless to extract video clips from a High Definition
Video at full resolution when the required size of your video clip is less than 100x80
pixels in most cases. This suggestion is very important for performance reasons; else
it could take hours or days to create a VideoMosaic. You need a video editing program
to resize your video.

2. Once we have a small video press the button T7ile Images—=>Extract Tiles from Video.
You will be asked to select a video (AVI file) and if successful you will see the Extract
Tiles Window with a preview of your video. Deselect the [x] JPG option (unless you also
want to create a photomosaics) and enable the [x] AVI option. Press the button
Random Frame and check that the white border is well visible and centered in the
frame. You can change the position/size of the white rectangle with the button Auto or
manually.

3. When ready press the button Extract. Right now this process will take a very very long
time (many hours) and it may seem that AndreaMosaic is frozen. But don't worry, it is
running without problems. This step will create a new Folder in the same Folder as your
video, with many very short Video clips that have a relatively static scene. There are
several parameters that define how the video clips are extracted. You can view/change
them with the new AVI button beside the checkbox.

At the end of the process you should have a good number of short video clips. Repeat this
process with other videos to build up a good collection of video clips. In my first examples I
extracted a collection of about 20,000 video clips from a few movies. Move all your clips in
a new folder.

Create a Tile List
In the Tile Images Window of AndreaMosaic:
1. Create a new list of images/videos to use as tiles with the New List button.
2. From the drop down list of the type of Folders select * Video Folders”.
3. Add to the list of folders the location of where you have saved all your short video
clips created in the previous step.
4. Press the button Save List to analyze your folders.
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Create a Photo Mosaic
Before creating your VideoMosaic you should first create a photo mosaic that will use the
first frame of the VideoMosaic. This is a fast and easy solution to tweak the parameters
before building the final video.
1. In the Main screen add an image to reproduce with the Mosaic.
2. In the Mosaic Size parameter select a small size for your Mosaic, I suggest one of
the predefined values, for example “Video HD 720p”. But any size in pixels is ok.
3. In the Tile Size parameter select a small value, I suggest between 50 tiles and 500
tiles for a video mosaic.
4. Play with the other parameters and at last build your mosaic. If you like the result
then you can proceed with the next paragraph.

Create a Video Mosaic

Switching from Photo Mosaic to Video Mosaic (and vice versa) is very easy: press the
button More Options and select “ Video Mosaic (uncompressed) (.AVI)" in the File Format
parameter. You can also select the compressed Video Mosaic format (smaller file size), but
in that case you will need to have/install the required codecs and to specify it in the
Advanced Settings. I don't suggest this choice, you can always use a Video Editing tool
to compress your video mosaic later on.

Other parameters like the length of the Video Mosaic are specified in the Advanced
Settings.

There are some advanced settings that a common user normally doesn’t change, these
options are available in the More Options>Advanced Settings button or also in the Extract
Tiles from Videos>AVI button. For each option there is a description of its meaning and
the default factory value. It is possible to replace the default values with the Save Default

Values button.
& Advanced Settings
Section Farameter Value -~ Options
Options Process Count 0 processes
. Process Count: | 0 v | processes
Options Memory Block 200 MByte
Options Priority very low
Options Mosaic Preview no Parallel Execution of some tasks in AndreaMosaic:
Opti Tile List Load 0 - Detect automatically the number of CPU's
P ?UHS ?e ' o no 1 - Use a single process only (no parallel execution).
Options Tile List Save no =0 - Use that number of processes / Parallel Execution.
Options Final Action ask -1 - Replace this value with the detected number of CPU's.
Options Tile Area Priarity center wide Default factory value: 0 processes.
Options Tile Size Priority lowrer
Image Compare Red Priority 1%
Image Compare Green Priority 1%
Image Compare Blue Priority 1%
Image Compare Medium Detail -1%
VideoMosaic Video Frames MAX™2 frames
VideoMosaic Video Frame Rate FREQ frames/sec.
VideoMosaic Default Frames 10 frames
VideoMosaic Default Frame Rate 10 frames/sec.
VideoMosaic Reverse Loop all
VideoMosaic FourCC uncompressed Codec
Extract Video Minimum 30 frames
Extract Video Maximum 400 frames
Carberzmt Viidan Vidan Thrachald innn e
OK Cancel Load Default Values Save Default Values
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